Windows Accelerated Submission and Processing
WINASAP 5010
Montana Medicaid, Healthy Montana Kids (HMK) and Mental Health Services Plan (MHSP)

August 2017
Table of Contents

Important Information ..................................................................................3
  Hardware/System Requirements for WINASAP Use ................................3
  Navigating in WINASAP ...........................................................................4
  Claims ........................................................................................................4
  Enrollment ..................................................................................................5
  Provider/Patient Information ......................................................................5
  Contact Information ....................................................................................5
  Initial Setup ................................................................................................6
  Setting Provider ID and Patient ID Character Length ..........................6
  Trading Partner/Submitter Setup .............................................................7
  Entering Taxonomy Codes ........................................................................8
  Entering Provider Data (NPI) .....................................................................9
  Entering Provider Data (Waiver/Atypical) ................................................10
  Secondary Identification ...........................................................................11
  Identification of Referring Providers .......................................................12
  Entering Patient Data ...............................................................................14
  Patient Data ..............................................................................................14
  Insured’s Data ...........................................................................................15
  Entering Procedure, Diagnosis, and Revenue Codes ..........................16
  Procedure Code Data ...............................................................................16
  Diagnosis Code Data ..............................................................................17
  Revenue Code Data ................................................................................17
  Creating a Professional Claim (CMS-1500) ...........................................18
  Claim Data ...............................................................................................18
  Claim Codes ............................................................................................19
  Claim Information .....................................................................................20
  Claim Line Items .......................................................................................21
  Creating an Institutional Claim (UB-04) ................................................22
  Claim Data ...............................................................................................22
  Claim Codes ............................................................................................23
  Claim Line Items .......................................................................................24
  Creating a Dental Claim ...........................................................................25
  Claim Data ...............................................................................................25
  Claim Information .....................................................................................26
  Claim Line Items .......................................................................................27
  Tooth Information .....................................................................................27
  Creating a Nursing Facility Claim Template (UB-04) ..........................28
Important Information

The software does not run consistently on tablets or Windows-based Macs. See Troubleshooting Tips for information. Users running Windows Vista and Windows 7, must right-click on the WINASAP icon and select “Run as administrator” every time the program is opened. Failure to do so will result in all data deleted upon exit!

Windows 8 must follow the instructions below to modify the shortcut. Failure to do so will result in all data deleted upon exit!

Prior to contacting the EDI Support Unit, consult this guide for solutions.

Hardware/System Requirements for WINASAP Use

- Windows Accelerated Submission and Processing (WINASAP 5010) is Windows-based (Windows 98, NT, 2000, XP, Vista, Windows 7, and Windows 8) software application developed by Conduent. WINASAP 5010 allows users to submit claim data electronically from their personal computer to EDI Solutions.
- WINASAP supports dial-up modem and high-speed transmissions. See Submitting Claimsthrough the MATH Web Portal.
- Software updates can be downloaded from http://medicaidprovider.mt.gov.
- If you do not run as administrator, the following error message appears:

![Error displaying error message]

- Windows 8 requires that you right-click on the WINASAP icon and click the Advanced button and select the Run as administrator. If you do not do this, your *.bil file will not be exported to the correct file location as indicated in the web portal instructions.
• Due to recent security updates, Windows 10 is no longer compatible with WINASAP.

Navigating in WINASAP

WINASAP opens as a mostly gray screen. The menu options are listed across the top: File, Reference, Claims, Tools, Window, and Help.

• WINASAP is not case-sensitive.
• Most Windows-based keyboard commands are available in WINASAP:
  – Tab key moves cursor from field to field.
  – Shift + Tab moves cursor back by field.
  – Control + C is a copy command.
  – Control + V is a paste command.
  – F5 enters the current date in a date field.
• WINASAP does not allow users to save an incomplete provider, patient, or claim entry. A claim must be placed in Hold status to save an entry.
• It is recommended that providers regularly back up their WINASAP database to prevent loss of data and to be able to recall data.

Claims

• We cannot offer coding advice including diagnosis and HCPCS codes.
• To submit electronic claim data to EDI Solutions, users must be enrolled as either a provider or an authorized billing agent for actively enrolled providers. This varies by payer; contact your Medicaid office for more information.
• WINASAP does not automatically prompt a user to save the claim. Canceling or exiting a claim prior to saving loses the claim.
• Keep claim lists short by deleting old claims on a regular basis. Large claim lists adversely affect software performance and increases error messages.
• Individual claims can be printed by selecting File/Print while the claim is open; however, printed claims are not valid for submission.
Enrollment

Users must complete the EDI Provider Enrollment Packet to submit claims electronically. EDI Solutions assigns a Trading Partner ID, User Name, and User ID. If you have registration questions or need technical support, contact the EDI Support Unit.

Provider/Patient Information

- Provider and patient information must be entered in the reference database prior to incorporating it into the electronic claim. Procedure, diagnosis, and revenue codes can be entered into reference databases, but do not have to be entered prior to building a claim; they can be entered directly from the Claim screen.
- Required fields are underlined on Entry screens; however, a claim may require additional information (e.g., prior authorization number, Passport referral number). This guide identifies all required fields.

Contact Information

Prior to contacting the EDI Support Unit, refer to Troubleshooting Tips for solutions. Call the EDI Support Unit at 1-800-987-6719 for WINASAP technical issues, electronic claims submission, rejects, and enrollment. Call Provider Relations at 1-800-624-3958 or 406-442-1837 with other claim questions.

Initial Setup

1. Enter the default password "asap" (not case-sensitive).
2. Click OK.

At initial setup, WINASAP prompts users to Select Payer.

1. On the pull-down menu, select Montana DPHHS. This is the only payer for which WINASAP allows submission.
2. Click OK.

This is a one-time-only setup. Subsequently, each time WINASAP is opened, Montana DPHHS will be set as the payer.
Setting Provider ID and Patient ID Character Length

This step must be completed before patients can be entered in the patient list with a card number. Note: Some Montana Healthcare Programs do use SSNs; however, that is subject to change.

Under File, select Open Payer.

1. Click the Show Payer Edits button.
2. Click Edit Values. A warning appears; click Yes.
3. Enter “7” in the Provider ID Minimum Length field and “10” in the Provider ID maximum Length field.
4. Enter “7” in the Patient ID Minimum Length field and “9” in the Patient ID Maximum Length field.
5. Click OK.
Trading Partner/Submitter Setup

The communications settings for Fields 1, 2, 10, 11, and 12 below can be found on the Welcome Letter sent by EDI. Under the File pull-down menu at the top of the screen, select Trading Partner.

1. Under Primary Identification, enter your 7-digit Trading Partner/Submitter ID Number assigned by EDI. (Hint: It always begins with 7.)
2. Under Secondary Identification, enter your Trading Partner/Submitter ID Number again.
3. On the pull-down menu, select Entity Type, either Person or Non-Person.
4. Enter Organization Name. If Person is selected under Entity Type, enter last name and first name in the appropriate fields. Middle name is optional.
5. Enter the Contact Name (name of billing person).
6. Enter the Telephone Number.
7. Enter the Fax Number (optional).
8. Enter the E-Mail address.
10. Enter the Host Telephone Number without dashes. Due to submission activity, you may get a busy signal when dialing the first number below. You may want to try one of the other lines.

   1-800-334-2832  1-800-334-4650  1-800-335-6165  1-800-335-6171

   If you need to dial a number to connect to an outside line, enter that number followed by a comma before dialing the rest of the number (e.g., 8,18003342832). If uploading to the MATH web portal, leave this field blank.

11. Enter the User ID # assigned by EDI as Password/User ID.
12. Enter the User Name assigned by EDI.
13. When completed, click Save.
Entering Taxonomy Codes
Does not apply to Waiver/Atypical providers.

You must create your taxonomy codes here. You may enter more than one taxonomy code. They are identified by descriptions.

If you do not add here, the drop down menu will not be populated when you enter provider data.

Under Reference, select Taxonomy Code. This opens the Taxonomy Code List. Click Add to add a taxonomy code to the list.

1. Enter the 10-digit alphanumeric Taxonomy Code.
2. Enter a brief description of the Taxonomy Code.
3. Click Save.
Entering Provider Data (NPI)

Does not apply to Waiver/Atypical providers.

Under the Reference pull-down menu at the top of the screen, select Provider. This opens the Provider list. Click Add to add a provider to the list. Important: If you make changes to your provider file, you must open each claim and reselect the provider from the drop-down menu.

1. Enter the provider's NPI.
2. In the pull-down menu select the correct provider taxonomy code from the Taxonomy Code Data pull-down menu.
3. On the pull-down menu, select Entity Type, either Person or Non-Person.
4. Enter Organization Name. If Person is selected under Entity Type, enter the Last Name and First Name in the appropriate fields. Middle Name and Suffix are optional.
5. Enter Provider Address (must be physical address, no post office boxes) including City, State, and ZIP code (ZIP + 4). If the +4 digits are unknown, contact EDI to verify the ZIP code on file.
6. Select ID Type for Provider Tax Identification Number.
7. Enter the provider’s Tax ID Number.
8. Enter the Contact Name (name of billing person/provider).
9. Enter the contact Telephone Number.
10. Enter the contact Fax Number (optional).
11. Enter the contact E-mail address (optional).
12. Enter Additional Contact Information (optional).
13. Click Save. The provider now appears in the provider list. To add additional provider numbers, follow the same instructions.
Entering Provider Data (Waiver/Atypical)

Under the Reference pull-down menu at the top of the screen, select Provider. This opens the Provider List. Click Add to add a provider to the list. **Important:** If you make changes to your provider file, you must open each claim and reselect the provider from the drop-down menu.

1. On the pull-down menu, select Entity Type, either Person or Non-Person.
2. Enter Organization Name. If Person is selected under Entity Type, enter the Last Name and First Name in the appropriate fields. Middle Name and Suffix are optional.
3. Enter the Provider Address (must be physical address, **no post office boxes**), including City, State, and ZIP Code (ZIP + 4). If the +4 digits are unknown, contact EDI to verify the ZIP code on file.
4. Select ID Type for Provider Tax Identification Number.
5. Enter the provider’s Tax ID Number.
6. Enter the Contact Name (name of billing person/provider).
7. Enter contact Telephone Number.
8. Enter contact Fax Number (optional).
9. Enter contact E-mail address (optional).
10. Enter Additional Contact Information (optional).
11. Click Next Page.
12. Choose Yes when this System Message appears: *Is this provider intended for Billing or Pay-to Plan provider?*
Secondary Identification

1. Under Identification Type, select Provider Commercial Number.
2. In the Identification Number field, enter the provider’s 7-digit Montana Medicaid Provider Number. You must include the leading zero (e.g., 0123456).
3. Click Save. The provider appears in the list. Repeat above steps to add additional provider numbers.
4. A System Message appears. Click Yes to save the atypical provider number.

**System Message**

You did not set any value in the NPI Number.
Are you sure the provider is not a mandated HIFAA National Provider Identifier (NPI)?

Yes  No
Identification of Referring Providers
You must add the provider in order for it to appear on the drop-down. See Entering Provider Data (NPI).

1. Click Reference >> Provider.

![Reference Provider](image)

2. Click Add.

![Add Provider Window](image)

3. Leave TIN blank.
4. When prompted with the System Message: Is this provider intended for Billing to Pay To Plan provider, choose No.

For additional information, refer to the applicable provider notice.

- Identification of Ordering and Referring Providers on UB-04 and 837I X12 Transactions
- Identification of Ordering and Referring Providers on CMS-1500 and 837P X12 Transactions
- Identification of Referring Providers on ADA Claim Form and 837D X12 Transactions
Entering Patient Data

Under the Reference pull-down menu at the top of the screen, select Patient. This opens the Patient List. Click Add to add a patient to the list.

Patient Data

1. Enter the Patient ID Number. This is a 7- or 9-digit number.

2. Enter the Patient Account Number. If users do not assign patient account numbers, enter the member ID number. Do not leave blank. If billing HMK/CHIP Dental, do not include the YDA prefix.

3. Enter the patient’s last name and first name in appropriate fields. Middle Name/Initial and Suffix are optional.

4. Enter patient’s Date of Birth (mm/dd/ccyy).

On the pull-down menu, select the patient’s Sex (once Female is selected, the option for indicating patient pregnancy is generated). If you are not billing Medicare primary, do not select the Medicare Recipient option.

5. Enter patient’s address, including City, State, and ZIP Code (ZIP + 4). If the +4 digits are unknown, enter 4 zeroes. Telephone Number is not required.

6. Click Insurance to go to the second screen.
Insured’s Data

1. In the pull-down menu, select Self. This automatically populates the appropriate fields in the upper section of the screen. **DPHHS members are always Self.**

2. In the Payer Responsibility Sequence Code pull-down menu, indicate whether Medicaid is primary, secondary, or tertiary.

3. Click Save. The patient now appears on the patient list and will be available when building a claim. Add additional patients using these same instructions.
Entering Procedure, Diagnosis, and Revenue Codes

Unlike provider and patient data, procedure codes, diagnosis codes, and revenue codes do not have to be entered into the reference databases prior to incorporating them into a claim. These codes can be entered directly into the Claim Entry screen.

Under the Reference pull-down menu at the top of the screen, select Procedure Code. This opens the Procedure Code List. Click Add to add a procedure code to the list.

Procedure Code Data

1. Enter the HCPCS code. Do not add code modifiers here.
2. Enter a description of the procedure/service.
3. Enter the usual and customary charge amount with 2-digit decimal. If your charge amount changes, you must update the charge. Only one charge can be entered for each code. Charges can be entered manually in the Claim Entry screen.
4. Click Save.

The procedure code now appears on the Procedure List. Add additional procedure codes using the same instructions.

Under the Reference pull-down menu at the top of the screen, select Diagnosis. This opens the Diagnosis Code List. Click Add to add a diagnosis code to the list. Enter ICD-10.
**Diagnosis Code Data**

1. Enter the Diagnosis Code with or without the decimal. It is recognized to follow after the third digit (e.g., 12310 = 123.10) if left blank.
2. Enter a Diagnosis Code Description.
3. Click Save. The diagnosis code now appears on the Diagnosis Code List. Add additional diagnosis codes using the same instructions.

Under the Reference pull-down menu at top of screen, select Revenue Code. This opens the Revenue Code List. Click Add to add a revenue code to the list.

**Revenue Code Data**

1. Enter the Revenue Code.
2. Enter the Revenue Code Description.
3. Enter the Revenue Code Charge Amount with a 2-digit decimal. If your usual and customary charge changes, you must update the charge. Charges can be entered manually in the Claim Entry screen.
4. Click Save. The revenue code now appears on the Revenue Code List. Add additional revenue codes using the same instructions.
### Creating a Professional Claim (CMS-1500)

Under the Claims pull-down menu at the top of the screen, select Professional. This opens the Professional Claim List. Click Add to add a professional claim to the list. **For existing claims, if any changes are made to provider, facility, or patient, you must open the claim and reselect the items changed.**

#### Claim Data

![Claim Data Diagram]

1. Enter the Bill Date (mm/dd/ccyy). Press the F5 key to enter the current date. Must be on or after last date of service.
2. Use the pull-down menu to access the Patient List; select Patient ID Number. For new patients, use the member card ID. For existing patients, if you have updated the Patient ID Number to the member ID number, be sure to select the correct entry.
3. Use the pull-down menu to access the Provider List; select the Billing Provider ID Number. The Pay-to Address is not needed. The Rendering Provider may or may not apply.
   a. If applicable, select referring provider here.
4. In the Signature on File field, choose the Yes option. This is mandatory.
5. Select Diagnosis Type Code ICD-10.
6. Enter the diagnosis code by keying in the diagnosis code or accessing the Diagnosis Code List using the pull-down menu. When keying diagnosis codes, the decimal point is not visible, but WINASAP recognizes it between the third and fourth digits based on the expanded length of ICD-10 codes. For diagnosis codes, the decimal point is not visible, but WINASAP recognizes it between the third and fourth digits based on the expanded length of ICD-10 codes. To enter additional diagnosis codes, click Other Diagnosis Codes.
7. Under the pull-down menu, select the Place of Service.
9. Click Next Page. Claim Status automatically defaults to Keyed. **This status changes once the claim is successfully submitted.** If billing a Rendering Provider, add the Provider Data in the Provider List following the previously stated instructions and select the

---

*Modem Only*
appropriate Provider from the pull-down menu. Waiver providers do not need to enter a Rendering Provider.

Claim Codes

1. If known, select the appropriate Medicare Assignment Code from the pull-down menu. If you do not bill Medicare, select Not Assigned. This is the recommended default. **This is a HIPAA-required field.**

2. Under Release of Information, users select the entry from the pull-down menu that best reflects their office protocol regarding release of information. **This is a HIPAA-required field.**

3. For Claim Filing Indicator **always** select Medicaid from the pull-down menu.

4. For the Benefits Assignment Certification Indicator, select Yes from the pull-down menu.

5. If the claim requires a Passport Referral Number, enter it here.

6. If the claim requires a Prior Authorization Number, enter it here. The prior authorization number may change due to various reasons (e.g., funds exhausted, service date changes, authorized codes). Update here when the prior authorization number changes.

7. Click Next Page.
Claim Information
In most cases, there are no required fields on this screen; however, there are two fields that may be required for the claim.

1. To enter the 2-digit **CSCT** team code, click Claim Note. The team code must be entered as a 2-digit numeric code. If you do not enter the team code as 2 digits, the claim will ultimately fail, although no error indication will be generated in this window.

2. To enter **TPL** information, click Other Subscriber Info. Other Subscriber Info (2) can be entered if the patient has additional insurance (TPL) that pays primary to Medicaid. **Do not enter $0 Pay.**

3. To enter paperwork attachment information, click Supplemental Info. Supplemental Info (3) can be used to indicate that a paperwork attachment to the electronic claim has been sent by mail/fax, or to reference a blanket denial letter on file in the Third Party Liability Unit. **Paperwork attachment information must be entered here.**

4. Click on **EPSDT** Info and select Yes for Certification Condition Indicator. In the Conditions drop-down, choose New Service Requested.

5. Click Next Page.
Claim Line Items
The number in the upper right corner of this screen indicates which line is being entered. As each line is added, this number changes. The total claim charges appear in the box on the lower left. Although WINASAP can accommodate 15 items in a single claim, the recommended maximum is 10.

1. Enter the Service Dates (mm/dd/ccyy). If a single date of service, enter the date in both fields.
2. Under the pull-down menu, **always** select HCPCS.
3. Enter the HCPCS procedure/service code. Either key in the code or access the Procedure Code list using the pull-down menu.
4. Enter up to four Procedure Modifiers.
5. Under the pull-down menu, **always** select Unit.
6. Enter the number of units being billed.
7. Enter the Charges. If the procedure code was previously entered into the Reference database with the corresponding per unit charge, WINASAP automatically calculates the charge.
8. Enter the Diagnosis Code Pointers. If there is only one diagnosis, then enter 1 in the first box.
9. Click Add Line Item. At this point, the claim line data moves to the box below. Repeat steps above to add additional lines.
10. When all line items have been entered, click Save.
Creating an Institutional Claim (UB-04)

Under the Claims pull-down menu at the top of the screen, select Institutional. This opens the Institutional Claim List. Click Add to add a new claim to the list.

Claim Data

1. Enter the Bill Date (mm/dd/ccyy). Press the F5 key to enter the current date.
2. Use the pull-down menu to access the Patient list; select the Patient ID Number.
3. Use the pull-down menu to access the Provider list; select the Billing Provider ID Number.
4. Enter the Admission Date.
5. Enter the Admission Type.
6. Enter the Discharge Status. Refer to the UB-04 Instructions for valid status codes.
7. Enter the Statement Coverage Period dates.
8. If required, enter the Prior Authorization Number.
9. Enter the Type of Bill.
10. Click Next Page.

*Claim Status automatically defaults to Keyed. This status changes once the claim is successfully submitted.
Claim Codes

* Personal Resource Amounts can be entered in Patient Responsibility Amount.

1. Select the Principal Diagnosis Code Qualifier from the pull-down menu. Choose ICD-10.
2. Enter the Principal Diagnosis Code either manually or from the pull-down menu (if previously saved in WINASAP 5010). When keying diagnosis codes with fourth or fifth digits, the decimal point will not be visible; however, WINASAP recognizes it between the third and fourth digits.
4. Enter the Admitting Diagnosis Code either from the pull-down menu (if previously saved in WINASAP 5010) or enter it manually. When keying diagnosis codes with fourth or fifth digits, the decimal point will not be visible; however, WINASAP recognizes it between the third and fourth digits.
5. If known, select the appropriate Assignment or Plan Participation Code from the pull-down menu. If unknown, select Not Assigned. This is the recommended default.
6. Under the pull-down menu, users select the entry that best reflects their office protocol regarding Release of Information.
8. Under the Assignment of Benefits Indicator, select Yes from the pull-down menu. This is mandatory.
9. If there is TPL that pays primary to Medicaid, click Other Subscriber Info to enter the TPL information (See Appendix A).
10. Click Supplemental Info to indicate that a paperwork attachment to the electronic claim has been sent by mail or fax, or to reference a blanket denial letter on file with the Third Party Liability Unit (See Appendix B).
11. Click Next Page.
Claim Line Items

1. Enter the Service Line Revenue Code or select it from the pull-down menu if it has been previously saved in WINASAP.

2. Select HCPCS from the Product/Service ID Qualifier pull-down menu.

3. Enter the Procedure Code or select it from the pull-down menu if it has been previously saved in WINASAP.

4. Enter up to four Procedure Modifiers.

5. Enter the Line Item Charge Amount.

6. Under the Unit or Basis of Measurement Code pull-down menu, **always** select Unit.

7. In the Service Units Count field, enter the number of units being billed.

8. Enter the Service Dates.

9. Click Add Line Item. Repeat these steps for additional line charges.

10. When all the lines have been entered, click Save.

The claim now appears in the Institutional Claim List window. Add additional claims using these same instructions.
Creating a Dental Claim

Under the Claims pull-down menu at the top of the screen, select Dental. This opens the Dental Claim List. Click Add to add a dental claim to the list.

Claim Data

1. Enter the Bill Date (mm/dd/ccyy). Press the F5 key to enter the current date. **Do not change the Claim or Encounter Identifier.**

2. Use the pull-down menu to access the Patient list; select Patient ID Number.

3. Use the pull-down menu to access the Provider list; select the Billing Provider ID Number.

4. In the Signature on File field, choose Yes.
   a. If applicable, select referring provider here.

5. Under the Place of Service pull-down menu, select the place of service.

6. Under the Claim Frequency Type Code pull-down menu, **always** select 1: Original (Admit thru Discharge Claim).

7. Under the Principal Diagnosis pull-down menu, select the principal diagnosis code qualifier. Choose ICD-10. **Montana does not currently required diagnosis codes on dental claims.**

8. Enter the principal diagnosis code either manually or from the pull-down menu if previously saved in WINASA P5010). When keying diagnosis codes with fourth or fifth digits, the decimal point will not be visible; however, WINASAP recognizes it between the third and fourth digits. **Montana does not currently required diagnosis codes on dental claims.**

9. Click Next Page.
Claim Information

1. **This is a HIPAA-required field.** Under the pull-down menu, users select the entry that best reflects their office protocol regarding release of information.

2. This is optional. To indicate EPSDT at the claim level, select EPSDT on the pull-down menu.

3. Under the pull-down menu, **always** select Medicaid.

4. Enter the first Date of Service.

5. From the Benefits Assignment Certification Indicator pull-down menu, select Yes. This is mandatory.

6. If COB, click Other Subscriber Info, and follow instructions in Appendix A.

7. Click Next Page.
Claim Line Items

1. If you have another Date of Service (a date that differs from the Date of Service entered on the previous page) enter the Date of Service (mm/dd/ccyy). If the Date of Service is the same as the previous page, leave this space blank.

2. Enter the CDT Procedure/Service Code. Either key in the code or access the Procedure Code List using the pull-down menu.

3. Enter up to 4 Procedure Modifiers.

4. Enter the number of Units being billed.

5. Enter the Charges. If the procedure code was previously entered into the Reference database with the corresponding per unit charge, WINASAP will automatically calculate the charge.

6. If applicable, click Tooth Information to enter the tooth information related to the line charge. See below for Tooth Information data entry instructions.

7. Click Add Line Item. Repeat steps above to add additional lines.

8. When all line items have been entered, click Save.

The claim now appears on the Dental Claim List. Add additional claims using the same instructions.

**Tooth Information**

1. Under the Tooth Code pull-down menu, select the code.

2. Under the Tooth Surface Codes pull-down menus, select the codes/quadrants.

3. When completed, click OK.
Creating a Nursing Facility Claim Template (UB-04)

Nursing facility claims use a template to expedite ongoing monthly billing. Once a template is created for each resident, subsequent claims are created by entering the billing month. WINASAP automatically generates a new claim for each resident. If any changes are made to provider, facility, or patient, you must open the template and reselect the items changed.

Under the Claims pull-down menu at the top of the screen, select Nursing Facility, then Nursing Facility Template. This opens the Nursing Facility Template List. Click Add to add a template to the list. Like all WINASAP electronic claims, patient and provider data must be entered prior to creating a template or claim. Since this a claim template, many of the date fields are left blank, but will be filled automatically when creating claims.

**Template Data**

1. Select the Bill Date. Press the F5 key to enter the current date.
   * Claim Status reads as Template.
2. Select the Patient ID from the Patient ID pull-down menu.
3. Select the Provider ID from the Billing Provider pull-down menu.
4. Enter the Admission Date (mm/dd/ccyy).
5. Enter the Admission Type Code. See the UB-04 manual.
7. Enter the Discharge Status (Default is 30).
8. Enter the Statement Coverage from Date (enter Admission Date mm/dd/ccyy).
9. Enter the Type of Bill (Default is 213).
10. Click Next Page.
1. Enter the Principal Diagnosis Code Qualifier.

2. Enter the Principal Diagnosis Code. When keying a diagnosis, users will not see the decimal; however, it is recognized to follow after the third digit (e.g., 12310 = 123.10).

3. Enter the Admitting Diagnosis Code Qualifier. Choose ICD-10.

4. Enter Admitting Diagnosis Code. Users will not see the decimal, but it is recognized to follow after the third digit (e.g., 12310 = 123.10).

5. If known, select the appropriate Medicare Assignment Code from the pull-down menu. If unknown, select Not Assigned. This is the recommended default. This is a HIPAA-required field.


7. Under Claim Filing Indicator Code, select Medicaid from the pull-down menu.

8. Select an Assignment of Benefits Indicator. Yes is required.

9. Click the Occurrence Span Codes button to change level of care from 2 (intermediate) to 1 (skilled). See the following page.

10. Enter the personal resources amount in the Patient Responsibility Amount field.

11. Click Next Page.
Template Line Items

1. In the Service Line Revenue Code field enter 160. Either key in the amount or access the Revenue Code List using the pull-down menu.
2. In the Unit or Basis for Measurement Code field, select Days from the pull-down menu.
3. Enter the Daily Rate.
4. Click Save.

There are no required fields on the Claim Home Health Data screen. The claim now appears on the Nursing Facility Template List. Add additional templates using the same instructions.

Occurrence Codes

The levels of care are Level of Care 1 = Skilled and Level of Care 2 = Intermediate. The default level of care is Level 2 – No action necessary. To indicate Level of Care 1:
1. Enter 70 in the Code field.
2. Enter the Date.
3. Click OK.
Creating a Nursing Home Claim from the Template List

Under the Tools pull-down menu, select Create Nursing Facility Claims.

**Create Nursing Facility Claims**

1. Enter month and year (mm/ccyy) in the Statement Coverage Period field.
2. Click the Build button.

WINASAP generates a claim for each Nursing Facility template for the month entered.

To make changes to claims, open the Nursing Facility Claims List under the Claims pull-down menu. Users select the claim they wish to change, make any changes, and click Save.
Submitting Claims

Under the Tools pull-down menu at the top of the screen, select Send Claim File. It is not necessary for users to select by claim type unless they wish to send different claim types in separate batches.

All Claim Lists must be closed.

To test the process before submitting claims for processing, use the Test indicator. **Claims submitted under the Test indicator will not be processed for payment.**

Send Claims

The default is set at Send Keyed Claims. (Claims that have not been billed.)

1. Click Production. Subsequently each time this screen is opened, it will be set to Production.

2. **Click Send. Failure to click Send results in duplicate files being submitted and processed.**

Once Send is clicked, the System Message appears indicating how many claims will be generated within this submission or batch. Click OK to send the claims. WINASAP begins the submission process.
Transmission Confirmation – Modem Only

Following transmission, users receive a confirmation message similar to the one below.

```
Transmission Confirmation

Date: 11/30/11         ACS Host System        Time: 10:10
User Name: MTTESTA     User Number: ********

<table>
<thead>
<tr>
<th>File Number</th>
<th>Payor</th>
<th>Fmt Type</th>
<th>Ver</th>
<th>Claims</th>
<th>Batches</th>
<th>Tot. Charges</th>
<th>Status</th>
<th>Msg</th>
</tr>
</thead>
<tbody>
<tr>
<td>11300907.009</td>
<td>77039</td>
<td>X12</td>
<td>92710</td>
<td>5010</td>
<td>2</td>
<td>1</td>
<td>1120.00</td>
<td>001</td>
</tr>
<tr>
<td>11300908.009</td>
<td>77039</td>
<td>X12</td>
<td>8970</td>
<td>5010</td>
<td>2</td>
<td>2</td>
<td>600.00</td>
<td>001</td>
</tr>
<tr>
<td>11300909.009</td>
<td>77039</td>
<td>X12</td>
<td>837F</td>
<td>5010</td>
<td>2</td>
<td>3</td>
<td>1500.00</td>
<td>001</td>
</tr>
</tbody>
</table>

Messages
001 - File received, will not be processed for payment.

** End of Report **
```

The Receipt Complete screen gives the submitter feedback regarding the submission.
1. The number of Claims submitted within the batch.
2. The total number of Batches.
3. The total amount of Charges.

This screen can be printed and saved for verification purposes.
Submitting Claims through the MATH Web Portal

For a number of reasons (e.g., no internal modem in the computer, having a digital phone line instead of an analog phone line) users may not be able to submit claims through WINASAP using an analog phone or fax line. Instead, they use the Montana Access to Health web portal to submit claims. However, if users do submit claims through the web portal, the Receive Response File and the automatic changing of the status of submitted claims is not available.

Users must register to use the MATH web portal before being able to use it to submit claims. If users do not have access, they should visit the MATH web portal, and follow the instructions to register (see your EDI Welcome Letter for necessary information.). Users need to assign their Security Privileges to include Upload Files. This must be selected before uploading the WINASAP claims.

The setup of WINASAP5010 is similar to that of previous versions.

1. Users enter their Trading Partner information as described earlier, leave the Host Telephone Number field blank, and click Save.

2. Enter the provider information, the member information, and the diagnosis codes. Create the claims, save them as described in this guide, and submit them following the steps described earlier.

3. After doing so, users receive a Transmission Claims message. This indicates that the claim file has been saved to their computer.

4. Click Cancel.

MATH Home Page

1. Once logged in, select the Upload Files option in the Submissions column.

   ![Montana Access to Health Web Portal Home Page](image)

   Navigate to any of the functions in the Web portal by clicking the following links or by using the top navigation bar. For information about each function, click the corresponding column header. Click on ‘My Profile,’ located in the ‘My Access’ section, to display your current Montana Access to Health Web Portal profile. You will be able to perform only those tasks allowed by the user privileges assigned to you.

   **Site Contents**

   - **Inquiries**
     - Eligibility
     - Claim Status
     - Provider Payment Summary
     - Electronic Health Record
     - Ask Provider Relations
     - Provider Locator
   - **Submissions**
     - Upload Files
     - View/Download Files
     - New File Upload
     - Add New User to Organization
     - Update or Remove User/Agent Password
     - Manage Submitter IDs
   - **Retrievals**
     - My Inquiries
     - My Retrieve
     - My Retrieve
   - **Manage Users**
     - My Profile
   - **My Access**
     - Change Organization
     - Change Password
     - Manage Employees
     - Manage Providers

   **ATTENTION PROVIDERS:** The Electronic Health Record link has been added to allow you to view your patients’ claims medical history. If you need this access and do not have it, please contact your office administrator. E-prescribing is now available. Please contact your office administrator to add prescribing rights to your user account.

   You’ve logged into the organization displayed under the navigation bar on the right. This organization will be used to determine the Provider Number and Submitter IDs you can use for your transactions (i.e., Inquiries, Submissions and Retrievals). To change this organization, click ‘Change Organization’ and follow the instructions.

2. Click the Browse button. This opens a Choose File window where users select their filepath.  
   **Note:** This option may be labeled differently depending on browser used.
3. Select the files in the order shown below by double-clicking the files.
   a. Local Disk (C :)
   b. Program Files
   c. Conduent (Previously ACS)
   d. W5010
   e. db
   f. 77039
   g. 77039.bil. This is the file location users’ claims are saved on their computer. The file path is C:\Program Files\Conduent\W5010\db\77039\77039.bil. The file name never changes. Users may verify the current file by the date changed.

4. Click the Upload button. Users should receive a message stating their file was successfully uploaded.

5. Users must now manually change the status of the claims they have just submitted through the MATH web portal. Users may call EDI one hour after upload to verify that the files have been received.

**Manually Changing Claim Status**

To manually change the status of claims, users must open the Claims List, select the type of claim (professional, institutional, dental, or nursing facility) they want to change, select the specific claim, and open the claim.

1. Click the pull-down menu next to Claim Status and select Hold.
   **Note:** The list is alphabetical; therefore, you must arrow up to locate Hold.

2. Click Save. This prevents the claim from being resubmitted with the next batch of claims if users choose to keep their submitted claims in the Claims List.
Running a Receive Response File

Wait a minimum of one hour before running this. Under the Tools pull-down menu, select Receive Response File.

1. Click Receive.

2. WINASAP connects to the host and updates the status of sent claims on Claims Lists. Unsent claims are in Keyed status. Sent claims default to Billed status.

Following the Receive Response File, sent claims are either accepted or rejected. If a claim is marked as rejected, contact EDI Gateway at 800-987-6719 or Provider Relations at 800-624-3958 for an explanation and for steps that are needed to correct rejected claims.
Reports, Backing up a Database, and Other Features

Under the Tools pull-down menu, select Reports. WINASAP can generate a variety of reports. Select the report type and criteria and click Run in the lower right of the screen. Other items of interest under the Tools menu are:

1. Back-Up Database
   a. By backing up a database, users ensure that data can be recalled in the event of data loss.
   b. A backup is recommended on a regular basis. Data can be backed up to the WINASAP database folders, your Desktop, a jump drive, or CD.
   1.) Select Tools >> Backup Database
2.) When the Confirm window appears asking if you want to Backup Database, click Yes. The default save path is C:\Program Files\Conduent\W5010\db\backup. If you wish to save to a flash drive, CD, or your Desktop, select the path.

3.) The backup process will run. When completed, a System Message appears.

![System Message]

2.) When the Confirm window appears asking if you want to Restore Database, click Yes. The default save path remains the same (C:\Program Files\Conduent\W5010\db\backup). If you wish to save to a flash drive, CD, or your Desktop, select the path.

3.) When the Confirm window appears asking if you want to include the Payor Table, click Yes.

4.) The Database Restore process will run. When completed, a System Message appears.

![System Message]
2. Purge Claims
   a. Select Tools >> Purge Claims to remove them from the Claim List.

   ![Purge Claims screenshot]

   b. Select the Cutoff Date. Claims transmitted before this date will purge. You may choose Claim Status Selection or Claim Type Selection. If you choose Status and upload to the MATH portal only, Hold and Keyed status are available options.

   ![Cutoff Date screenshot]

   c. You may also choose Claim Type Selection and either Select by Claim Type or Select All Claim Types.

   ![Claim Type Selection screenshot]
d. When the Confirm window appears asking if you want to purge selected claims, choose Yes.

e. You will be prompted to make a backup before the purge begins. The default save path is C:\Program Files\Conduent\W5010\db\backup. To point to a flash drive/CD/desktop select the path.

f. Once removed, purged claims can be found in the WINASAP Database File.

3. Security

a. Passwords may be changed, and users can be added through the Security option. This is not recommended. If you forget the username or password, EDI Support cannot provide this information to you.

4. To view the version of WINASAP being used, choose Help >> About. A screen appears indicating the version being used (e.g., Version 1.09).

5. Database Repair Tool. This item can be used to troubleshoot minor glitches or errors that are experienced within the software.

a. Select Tools >> Database Repair Tool.

b. The database repair process will run.
Once the Database Repair Tool is complete, restart computer before proceeding.
Troubleshooting Tips

1. **Claims, Denied; the Receive Response File Shows as Accepted.** When claims are submitted electronically, they are screened for validity of data and HIPAA compliance. If the submitted claims fail to meet these criteria, they are rejected from processing. If all criteria are met, the electronic claim gets accepted; however, this status means that the claim was received by Medicaid for processing. A claim can still be denied for many reasons. **Note:** When uploading through the web portal, all Receive Response options are disabled. To confirm submission, contact the EDI Support Unit at least 1 hour after submission.

2. **Claims, Same Patient Same Codes.** Use the Copy feature in the Claim List to copy the claim and allow updates to it. This saves data entry time because updates can be done to the data that changes (e.g., bill dates, services dates) and the rest is already entered.

3. **Database, Backup.** We recommend backing up data on a flash drive to store at an alternative location in the event that something happens to the computer on which WINASAP is installed.

4. **Database, Restoring.** Restoring a database will overwrite current data. There is no function to combine parts of multiple databases.

5. **Downloading WINASAP Software.** Available at [http://medicaidprovider.mt.gov/claims](http://medicaidprovider.mt.gov/claims). When downloading WINASAP, save it to the computer Desktop and install the program from there. The installation software looks like a red box. Once installed, the actual WINASAP application resembles a globe with red writing on it. To determine what version you are running, click Help > About...

   Once WINASAP is successfully installed, delete the installation box to prevent from installing the software again. If the database is not backed up to an external location and WINASAP is installed over the top, all previously entered data will be lost.

6. **E-101 System Error.** Check that you are running as administrator and restart computer.

7. **Modem Not Accessible.** Choose device. WINASAP is direct submission software; therefore, a direct submission method must be reflected. The system that best reflects that is a dial-up modem and phone line. Many computers have internal modems and can simply have a phone or fax line plugged directly into the computer to resemble direct submission compliance. To find an active modem on the computer, access the Control Panel.

8. **Payer.** Ensure the right payer (Montana DPHHS) is selected before submitting claims. The payer is indicated in the blue bar at the top of the screen.

9. **User Not Approved for Payer/Format/Type.** This error occurs on the Receipt Complete screen. To resolve this issue, contact the EDI Support Unit at 800.987.6719.

10. **User Unable to Submit Claims (Option Is Not Available).** Close all data entry screens before submitting claims so only the gray WINASAP screen shows.

11. **Screen That Was Open Has Disappeared.** Multiple screens can get concealed behind one another. Minimize the open screens to determine whether a screen is hidden behind it. The minimized screens can be maximized again.

12. **Patient or Provider ID is not the right length.** Manually modify the length allowed for the patient or provider data ID under File/Open Payer/Show Payer Edits.

13. **Receive Response File.** It is beneficial to know if claims are rejecting on the electronic submission. If nothing comes through on the remittance advice, this is an indicator of claims rejecting.

14. **Running WINASAP on a Mac.** Users attempting to run WINASAP on a Mac may find the program does not work to its full extent. WINASAP has run successfully on a Mac, but overall its functionality does not operate well. Users do need a Windows parallel because WINASAP is Windows-based. Support for this is limited.

15. **WINASAP on CD.** Users who wish to have a CD sent to them instead of downloading WINASAP from the website should call Provider Relations at 1.800.624.3958 or the EDI Support Unit at 800.987.6719.
Appendix A – Indicating TPL Payments in a WINASAP Claim

If users need to indicate that Medicaid is not primary on a patient, access the patient data through Reference/Patient. Once the Patient List comes up, users can either double-click the patient to access or select the Change tab.

For WINASAP professional claims in which Medicaid pays secondary or tertiary to another insurer (TPL), providers should follow these instructions to enter the TPL paid amount and other TPL information.

Claims indicating a TPL payment (not including Medicare) do not require attached paper documentation. However, an attachment is required if the TPL denies payment for noncovered services, exceeded benefits, etc. Do not enter $0 Pay.

The numbers on the screen shot below indicate the fields required to indicate Medicaid as secondary or tertiary.

1. In the Patient Reference Database, on the Insured’s Data tab, under Patient Relationship to Insured, be sure that Self is entered.

2. Under Payer Responsibility Sequence Code, select Medicaid as Secondary (or Tertiary, if applicable).

3. Click Save to exit the screen.
On the Professional Claim Data screen, **Claim Information tab**, click Other Subscriber Info.

Other subscriber information allows the entry of many different aspects of third party payers, including Medicare.

- For Professional claims, Other Subscriber Info is located on the Claim Information tab.
- For Institutional claims, Other Subscriber Info is located on the Claim Codes tab in the bottom row of tabs.
- For Dental claims, Other Subscriber Info is located on the Claim Information tab near the bottom.
- For Nursing Facility claims, Other Subscriber Info is located on the Claim Codes tab in the bottom row of tabs.
Other Subscriber Page 1

Complete the following fields on page 1 of this screen.

1. Patient Relationship to Insured.
2. Entity Type.
3. Last Name and First Name.
4. Insured’s Primary ID Type.
5. Insured’s Primary ID.
6. Click OK or the Other Subscriber Page 2 tab at the top to move to the second page.
Other Subscriber Page 2

Complete the following fields on page 2 of this screen.

1. Group or Policy Number.
2. Group or Plan Name.
3. Insurance Type Code.
7. Payer Name.
9. Payer Primary ID Type.
10. Payer Primary ID.
11. Claim Check or Remittance Date.
12. Click COB Amounts.

**COB Information**

1. Enter the Paid Amount (TPL payment). Be sure to indicate payment with a 2-digit decimal to ensure the amount comes across correctly (e.g., 100.00 not 100).
2. Click OK. Repeat the process for other TPL payments on the claim.
Appendix B – Indicating Medicare Part B for a Professional Claim

Follow the same procedures to indicate in the patient’s data that Medicaid is either Secondary or Tertiary. (See the Running a Response File instructions on page 35.)

When entering the Professional Claim, on the Claim Codes tab, enter Assigned for the Medicare Assignment Code.

![Claim Codes screenshot]

Proceed to follow normal claim billing procedures.
Other Subscriber Page 1

On the third page of data within a Professional Claim, select Other Subscriber Information.

Complete the following fields on page 1 of this screen.

1. Patient Relationship to Insured: Self.
2. Entity Type: Person.
3. Last Name and First Name.
4. Insured’s Primary ID Type: Select Member Identification Number. Insured’s Address is not required.
5. Insured’s Primary ID: Enter patient’s Medicare ID Number.
6. Click the Other Subscriber Page 2 tab at top to move to the second page.
Other Subscriber Page 2

Complete the following fields on page 2 of this screen.

1. Group or Policy Number.
2. Group or Plan Name.
3. Insurance Type Code: Medicare Part B.
4. Claim Filing Indicator: Medicare Part B.
5. Release of Information Code: Select the first option.
6. Patient Signature Source Code: Select the first option.
7. Payer Name: Noridian Medicare.
9. Payer Primary ID Type.
11. Claim Adjudication Date: The date the claim processed in Medicare.
12. Click COB Amounts.
COB Information
1. Enter the paid amount to indicate the total amount paid by Medicare on this claim. Indicate the payment with a 2-digit decimal to ensure the correct amount comes across (100.00 not 100).
2. Click OK. Repeat this process to add any additional payments.

Claim Line Items
1. Under Additional Line Item Information, select the Line Adjudication Info button.
2. For Other Payer Primary ID, select the pull-down menu, and indicate the same Payer Primary ID entered previously (MCARE PART B).
3. Enter the paid amount in the Service Line Paid Amount field.
4. In the Adjudication or Payment Date field, enter the adjudication date of the claim.
5. Select the Service Adjustment button.
   a. Group Code – Select the appropriate code identifying the general category from the pull-down list.
   b. Reason Code – Select either 1 Deductible Amount or 2 Coinsurance Amount from the pull-down list.
   c. Adjusted Amount – Enter the amount of the deductible or coinsurance.
6. Select Product or Service ID.
   a. Identification Type – **Always** select HCPCS from the pull-down list.
   b. Identification Number – Enter the appropriate procedure code from the corresponding line item.

7. In the Proc Code Description field, enter the procedure code description.

8. In the Paid Service Unit Count field, enter the number of paid units.

9. Click OK.

If there are additional service dates that need to be billed, click the Add Line Item button and repeat the steps for each additional line items.
Appendix C – Paperwork Attachments / Blanket Denial Letters

For WINASAP claims in which a provider must indicate that a separate paperwork attachment has been sent, or to reference a blanket denial letter on file in the TPL Unit, click the Supplemental Info button.
**Supplemental Information**

The black numbers on the screen images indicate required fields.

1. Under the Report Code pull-down menu, select the type of attachment (e.g., EOB). If the exact definition is not listed, select Support Data for Claim.

2. Under the Transmission Code pull-down menu, select the appropriate code (e.g., By Mail for attachments sent by mail with the Paperwork Attachment Cover Sheet; Electronically Only to reference a Blanket Denial Letter on file in the TPL Unit).

3. In the Identification Code field, enter the Attachment Control Number for attachments sent by mail with the Paperwork Attachment Cover Sheet. This number consists of the provider’s NPI, member’s ID number, and date of service (mmddccyy) each separated by a hyphen. This number muchmatch the Paperwork Attachment Control Number entered on the Paperwork Attachment Cover Sheet.

   For claims referencing a blanket denial letter on file in the TPL Unit, enter the reference number assigned by the TPL Unit. The format of this number is TPL + Member ID Number + Carrier Code with no hyphens between the three elements.

4. When completed, click OK.